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About This Manual 

This User’s Manual provides the information you need to configure, 
operate, and troubleshoot the KODAK APPROVAL Interface Toolkit 
(AIT). AIT can be installed on the following: 

� KODAK APPROVAL XP Digital Color Proofing System host 
computer 

� KODAK APPROVAL XP4 Digital Color Imaging System host 
� Computer. 
� KODAK APPROVAL NX Digital Color Imaging System host 
� Computer. 
� PC dedicated to AIT only 

Installing AIT on the KODAK APPROVAL XP/XP4/NX host provides 
full proofing parameter capabilities; however, the full resources of a 
dedicated PC are required to provide Rotation and Tiling functionality. 



 

 

This manual is intended to be read and used by people performing 
two types of tasks: 

� System administration—main tasks are installation and 
configuration. This person should have a thorough knowledge of 
the WINDOWS NT, 2000 and XP operating systems and should 
have experience setting up PCs. This individual should also be 
knowledgeable in computer systems networking, including 
Ethernet, networking compatibility, and data communications. 

� Operations—uses the AIT application to make proofs. The 
operator should be familiar with PCs as well as with proofing 
operations on KODAK APPROVAL XP/XP4/NX devices. 
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1 AIT Overview 

This chapter provides an overview of the KODAK APPROVAL Interface 
Toolkit (AIT) functionality, communication, and configuration. 

AIT provides a connection between a Raster Image Processor 
(sometimes referred to as RIP, or a Digital Front End or DFE) and all 
KODAK APPROVAL XP/XP4/NX Digital Color Proofing devices 
(APPROVAL XP/XP4/NX devices). 

AIT is a hardware and software solution that accepts screened bitmap 
files from a RIP, and then converts the bitmap files to the output format 
required by APPROVAL XP/XP4/NX devices. AIT hardware consists of 
a dongle that acts as a Hardware Against Software Piracy (HASP) that 
is required for enabling AIT software. 



 

 

AIT Overview 

AIT Functions 
AIT converts rasterized images in TIFF or DCS2 format for output to an 
APPROVAL XP/XP4/NX device in an Open Front End (OFE) format. 

In addition to its file conversion capabilities, the AIT interface also 
allows you to: 
� Define and process recipe colors 

� View and zoom TIFF files in Viewer Mode 
� Tile image files to make proofs even when the size of the image is 

larger than the proofing device’s maximum capability (dedicated 
PC only) 

Inputs and Outputs 
AIT Inputs—accepts screened bitmap files in TIFF, TIFF/ini, and 
DCS2 formats. 

AIT output—sends 2400 or 2540 dpi output to APPROVAL 
XP/XP4/NX devices via the OFE interface. 
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RIP/AIT Communication 

RIP/AIT Communication 
The AIT converts the image file and sends it to the APPROVAL 
XP/XP4/NX device using OFE protocol. This can be implemented 
automatically or manually. 

The RIP provides AIT with one of the following: 

� TIFF file and proofing parameters in the structure of an .ini file 
� TIFF or DCS2 file without proofing parameters 

In cases where the RIP supplies no .ini file, proofing parameters are 
provided in an operator-generated template .txt file. 

The proofing parameters included in a template .txt file, and RIP-
created .ini files are similar and contain the following information: 

� Path to individual separation (CMYK, recipe, or special colors) 
� Screen ruling 
� Angles 
� Laydown order 
� Donor mapping 
� File height and width 

NOTE: Path information does not appear when viewing 
parameters in Show Export Setup. 

Modified .ini files contain the number of separations and the 
separation file names. A template must be created and applied to 
provide the remaining parameters. Examples of these files are 
contained in “Appendix B Proofing Parameter Files” on page 127. 



 

 

AIT Overview 

Some workflows allow you to have multiple RIP output/AIT input 
folders with multiple hot folders so you can specify different proofing 
parameters. This illustration shows how hot folders are used to apply 
proofing parameters to image files contained in the AIT input folders. 
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AIT Configuration Diagrams 

APPROVAL Digital Color Proofing Devices 
AIT provides output to the following APPROVAL XP/XP4/NX devices. 

KODAK APPROVAL Digital Color Proofing Devices 

Proofing Device Resolution (dpi)       Proof Size 
(mm) 

Page 
Layout 

APPROVAL XP 2400 2540 338 x 529.92 2-Page 

APPROVAL XP4 2400 2540 676 x 529.92 4-Page 

APPROVAL NX 2400 2540 338 x 529.92 2-Page 

APPROVAL NX 2400 2540 676 x 529.92 4-Page 
 

AIT Configuration Diagrams 
AIT installed on the host or a dedicated PC is configured for output 
only to APPROVAL XP/XP4/NX devices via a network. 

 



 

 



 

  13

2 Configuring AIT 

This chapter provides instructions for configuring the KODAK 
APPROVAL Interface Toolkit: 

� Establishing OFE socket communications between AIT and a 
KODAK APPROVAL XP/XP4/NX Digital Color Proofing device 
(APPROVAL XP/XP4/NX) 

� Creating hot folders that enable the automatic transfer of files 
from the RIP output folder (also acts as the AIT input folder) to an 
APPROVAL XP/XP4/NX device 

� Creating template .txt files to define proofing parameters for 
DCS2 files and TIFF files with modified .ini 

Start AIT by double-clicking the desktop icon.  

The main AIT screen appears. Begin your configuration procedures 
from this screen. 
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How Do I Configure AIT for My System? 
AIT configuration procedures required for your system depend upon 
the format of the files received from the RIP. The APPROVAL 
XP/XP4/NX device accepts three file formats: 

� TIFF/.ini 
� DCS2 

The following table illustrates the configuration steps required for 
each file format received by AIT. 

File 
Type 

Device 
Setup 

Create Hot 
Folders 

Create 
Template 

TIFF/ini Yes Yes Conditional * 

DCS2 Yes Yes Yes  
* In some cases, the .ini file received from a RIP requires additional 

Proofing parameters. 
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Defining the Device Setup 
Define the device setup to establish the connection between the AIT 

and the APPROVAL XP/XP4/NX device. Use the Device Setup Wizard 
to establish OFE socket communication with the APPROVAL 
XP/XP4/NX host. 
 

 

1. Be sure the host software is 
running. 

2. On the AIT window, click the 
Device setup wizard icon. 

The APPROVAL Device Type window 
appears with a list of the proofing 
devices configured for your site. 

 

3. Double-click New Device. 
 
The next APPROVAL Device Type 
window appears. 

 

4. Select the Approval device to 
which you wish to connect. 

5. Select a Host version 

6. Click Next 
The AIT Location window appears 
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7. From the drop-down list, select a 
RIP identifier that corresponds 
to the RIP you will connect to. 

 

This is the source of the input files 

 

8. If installing on the host PC, click 
Test Connection 

A yellow smiley face indicates the 
connection was made. If the connection 
was not made, the host software may 
not be running. 

TIP: It is recommended that you test the 
connection each time you set up a new 
device 

 

9. Click NEXT 

The APPROVAL Host connection 
window appears.  If you are installing 
on the host, the final parameters 
window appears. Go to Step 13  

 

 

10. Enter the name of the APPROVAL 
host and its IP address. 
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11. Click Test Connection 

A yellow smiley face indicates the 
connection was made. If the 
connection was not made, the host 
software may not be running. 

12. Click Next 

The Final parameters window appears 

13. Enter a name for the device and 
any optional comments. 

Note:  This is the device name that is 
listed in the APPROVAL Device Type 
window 

14. Click Finish 

The APPROVAL XP/XP4/NX device 
appears in the list of devices 
configured for your site. 

 

15. Do one of the following: 

• Double-click on a device to verify 
the settings. 

• Click New Device to set up 
another device. Return to Step 4. 

16.  Click Finish to complete the 
setup. 

You have established the connection 
between the AIT and an APPROVAL 
XP/XP4/NX device 
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Setting Up Hot Folders 
Hot folders allow the automatic transfer of TIFF/.ini and DCS2 files 
from the RIP to your APPROVAL XP/XP4/NX device. The hot folder 
setup defines proofing parameters that are applied to an image file 
when it is received in the AIT input folder. Hot folders provide the 
following proofing parameters: 

� Job destination 

� Donor laydown order 

� Donor mapping 

� File trigger mechanism 

Before You Begin 
Have the name and location of the RIP output folder available. If you 
have not created an output folder for your RIP, do so now. This folder 
becomes your AIT input folder. 

In addition, if the RIP output provides TIFF with modified .ini file, TIFF, 
or DCS2 files, the AIT input folder must also include a template .txt 
file. 

A full-size uncompressed file for an APPROVAL XP4/NX device may 
require up to 1.8 GB of space. Make sure that you have enough disk 
space to accommodate the files you’ve successfully proofed, and that 
you wisely define the time to hold them. 

Predefine your laydown order and donor mapping template. For the 
steps to do so, see “Using Donor Colors” on page 52. 
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Hot Folder Setup 
 
 1. If you do not have an output folder for 

RIP, create it now. 

 
 

 

2. From the Mode menu, select Hot 
Folders Setup. 

 
The Hot Folder Setup window appears 

 3. Double-click New Hot Folder 
4. Type the name of your new hot folder 

in the Hot Folder Name text box. 
TIP: To help organize your workflow, the 
hot folder name can be based on the AIT 
input folder name 
 
5. Select the location (pathname) of the 

RIP output folder in the Directory text 
box 

6. Select the input tab 
IMPORTANT: Do not click OK at this 
point or you will have to start over 
 
7. Select the Device Name from the 

drop-down list. 
This is the device name that was 
assigned during the Device Setup (see 
“Defining the Device Setup” on page 17) 
and it is the device to which you are 
directing this hot folder 
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8. Select the Output tab 
9. For any or all of the following, click 

Active then select: 
• Tiling Scheme 
� Donor Mapping 
� Donor Laydown Order 
� Image Options 

I M P O R T A N T :  T h e s e  m u s t  b e  p r e d e f i n e d .  

See “Using Donor Colors” on page 52 
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10. Select the Settings tab 
11. Set the available options 
 

Stabilize Time— specify when files are 
placed in the hot folder; no actions can be 
performed on the files for the time period  
Comment— enter optional information to 
identify the hot folder 
Hot Folder Priority— inactive at this time 

 

12. Select the On Success tab 
Do not change these settings during initial 
testing of the system. However, once AIT is 
up and running, change the settings to define 
how you wish to handle successfully proofed 
files. If these settings are not changed for 
normal operation, the hard drive becomes 
full. 
 
NOTE: If you select the Move To option, AIT 
automatically creates a "Done"folder in the 
path displayed in the drop-down list. 
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13. Select the On Error tab 
Do not change these settings during initial 
testing of the system. However, once AIT is 
up and running, change the settings to define 
how you wish to handle successfully proofed 
files. If these settings are not changed for 
normal operation, the hard drive becomes 
full. 
 
NOTE: If you select the Move To option, AIT 
automatically creates an "Error" folder in the 
path displayed in the drop-down list. 
 

14. Click OK when your selections are 
complete 

 
The Hot Folders Setup window appears 

 

15. Click in the box next to the hot folders 
that you wish to be active 

A check mark appears in the box 
16. Click OK. 

 
NOTE: The Export field on the AIT window 
displays the job destination. 

 

17. From the Mode menu, select 
Streamer and Plane By Plane. 

 
These two modes provide the most efficient 
way to transfer files. In Streamer mode, as 
files come into AIT they are transferred to the 
host. Plane-By-Plane mode means that each 
separation is transferred to AIT and then the 
host separately, or plane-by-plane. 

 

18. (OPTIONAL) Select Show Export 
Setup from the Setup menu, if 
necessary. 

 
NOTE: When selected, this option stops 
AIT processing of each image file until the 
operator accepts the proofing parameters. 
After you are satisfied that the settings 
are correct, you can turn off this feature. 
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Creating Templates 
Templates are operator-generated .txt files that provide proofing 
parameters for DCS2 files, as well as additional proofing parameters 
for modified TIFF/.ini files. Templates are placed in the AIT input (RIP 
output) folder and are applied to files as they are processed through 
the hot folder mechanism. 
Templates define the following proofing parameters: 

� Separations used when proofing 

- Density 

- Screen ruling 

- Angle 

� Offset 
� Media saving 

� Number of copies 

� Recipe Lists 

Before You Begin 
Have the name and location of the RIP DCS2 and TIFF/.ini output 
folders available. If you have not created an output folder for the RIP, 
do so now. This folder becomes your AIT input folder. 

When defining separation density settings, remember that each step in 
the density range yields a change of 0.025 Status ‘T’ (for C, M, K) or 
0.0125 Status ‘T’ (for Y). Value “0” is a nominal mid-level SWOP 
density, measured above paper density, approximately at these 
values: 1.46 for K, 1.17 for C, 1.25 for M, 0.73 for Y. 
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Creating a Template  

 

1. From the Templates menu, select 
Tiff/.Ini Template. 
The KODAK APPROVAL Setup window 
appears. 

2. Double-click a separation to define the 
parameters. 
A check in the box next to the separation 
indicates that it will be included in the 
template. 
NOTE: If the Cyan separation is selected first,

the change made to the Screen 
Ruling is applied to all separations. 

The Separation Parameters window appears. 
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The KODAK APPROVAL Setup window 
appears. 

5. Repeat steps 2 through 4 to select and define 
other separations as necessary. 

6. Select additional options as necessary: 

� Offset— define the offset of the proof in 
reference to the top-left corner of the output
media. The offset may be defined in pixels, 
millimeters or inches. 

� Copies— select the number of copies 
you wish to print. 

� Recipe Lists— select the recipe Lists 
you wish to use. 

� Media Saving— check this box if you wish 
to save donor material. 

 

3. Enter the following parameters: 

� Density— enter the density parameter for 
this separation. The valid values are integer 
numbers from -99 to +99 for process colors. 

IMPORTANT: Do not change the density of 
recipe colors from this window. 
See “Using Recipe Colors” on 

page 49. 

� Screen Ruling— enter the screen ruling 
value for the screened data in this 
separation. The valid values are from 0 to 
500. 

� Angle— enter the screen angle value for the 
screened data in this separation. The valid 
values are from -359.9 to +359.9. 

4. Click OK. 



 

  26

 

 

7. Click Generate Template. 

The Browse for Folder window appears. 
8. Navigate to, and select the RIP output folder. 
9. Click OK 

The new template is stored in the selected 
folder and the exapproval window appears 

.

 

10. Click OK. 

The template .txt file is created and stored in 
the selected folder, and the KODAK 
APPROVAL Setup window appears. 

11. Repeats step 2 through 10 to create additional
templates as necessary. 
OR 
Click Cancel to exit the KODAK APPROVAL 
Setup window. 
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3 Using AIT 

This chapter describes how to make proofs using your APPROVAL 
XP/XP4/NX Color Proofing device. It describes the KODAK 
APPROVAL Interface Toolkit screen and features, how to work in 
each of the AIT operation modes, and how to use recipe and donor 
colors. 

To familiarize yourself with the user interface before learning about 
AIT procedures, go to page 32. 

To begin learning about AIT procedures and bypass the user interface 
description, go to page 40. 
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Working with AIT Menus and Buttons 
The menus and toolbar buttons provide quick access to AIT functions. 

Main Toolbar Buttons 
The AIT main toolbar buttons are used for AIT configuration, for 
selecting proofing modes, and for proofing files. 

For information about an icon, place the cursor over the icon. The description appears in the 
status bar at the bottom of the screen. 

 TIFF Bitmap 
Last Acquire

Last Export 

Activate Hot Folder

Main Toolbar 

Device Setup Wizard 

Status Bar: Icon 
description 
appears here 

Link Setup Wizard (inactive)  
Viewer/Streamer Modes

Plane by Plane 
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Separations Toolbar Buttons 
AIT separations buttons are used to view different perspectives of 
images when working in Viewer mode. Only TIFF files can be viewed. 
The separations buttons are active when there is an image displayed on 
the AIT screen. The separations buttons are inactive (grayed out) when 
no image is displayed. 

For information about an icon, place the cursor over the icon. The description 
appears in the status bar at the bottom of the screen. 

Zoom 
 Combined view of separations 

View single separation 

View in color/monochrome 
Color Simulation Table
CMYK

Crop (Inactive) 
No Zoom (Pan) 

Full Detail 
Full Picture 

Picture 
Information 

Separations 
Toolbar 
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AIT Main Menus 
AIT main menus are available when no image is displayed in the AIT 
window. 

 

File Menu 
 

The File menu options allow you to work with files to be proofed. 

New—create a new file. 

Open—open an existing file. 

Close—close the current file. 

Acquire—import the files you wish to proof. The file types that you 
may acquire are: TIFF Bitmaps, DSC2 data files, and raw data files 
sent to the host by the RIP. 

Preferences— set your system parameters as follows: 

Units— pixels, inches, millimeters, centimeters 

Scratch Disk— choose a drive to use for temporary files. 

Last Acquire— import the last file acquired. This menu option has the 
same functionality as the Last Acquire main toolbar button. 

Exit— close the AIT application. 

AIT Main Menus 
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View Menu 
 

The View menu allows you to display or hide the following parts of the 
AIT interface: 

Main Toolbar 
Separations Toolbar 
Streamer Toolbar 
Status Bar 

Templates Menu 
 

The Templates menu allows you to define the following proofing 
parameters: 

TIFF/.Ini Template— creates operator-generated .txt files that 
provide proofing parameters for DCS2 and TIFF files, as well as 
additional proofing parameters for modified TIFF/.ini files. 

Rotation/Tiling Template— allows you to use the plate setter image 
when making proofs. 

NOTE: The Rotation/Tiling Template can not be used when AIT is 
installed on the KODAK APPROVAL XP/XP4/NX host. 

Donors Mapping Template— provides global substitution of donor 
colors for both Process and recipe colors. 

Donors Layout Order— specifies the order in which donor colors are 
applied to a proof. 

Recipe Builder— lets you define recipe colors. 

Recipe List Manager—lets you save groups of recipe colors. 

Recipe Search Engine—lets you search for groups containing a 
recipe 
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Setup Menu 

 

Help Menu  
The Help menu displays AIT software version information. 

 The Setup menu allows you to enable/disable OFE functionality. 

Approval Device Setup Wizard— configure the connection between 
AIT and your APPROVAL XP/XP4/NX device. This menu option has  
the same functionality as the Device Setup Wizard button. 

Link/RIP Setup Wizard— inactive. 

Show Export Setup— used during Manual or Automatic mode 
proofing to verify proofing parameters. 

Hot Folders Setup— opens the Hot Folders Setup configuration 
window (for functionality, see “Setting Up Hot Folders” on page 21). 

 

Mode Menu  
The Mode menu allows you to set the proofing mode. 

Viewer—check to activate Viewer mode. This mode is used to view 
images in raw data or TIFF files. 

Streamer—check to activate Streamer mode. This automatically passes data from the
RIP to the APPROVAL XP/XP4/NX device.

Plane by Plane—check to activate Plane by Plane viewing. This 
mode acquires images separation plane by separation plane. 

Activate Hot Folders—check to begin automatic Hot Folder proofing. 
This menu option has the same functionality as the Activate Hot  
Folder button.

 



 

 

Working with AIT Menus and Buttons

 33 

AIT Image Menus 
The AIT image menus are available when an image is displayed in the 
AIT window. 

AIT Image Menus 

 

File Menu 

The File image menu options allow you to work with files to be 
proofed. 

New—open a new file. 

Open—open an existing file.  

Close—close the active file. 

Acquire—import the file types you wish to proof. The file types that 
you may acquire are: TIFF Bitmaps, DSC2 Data files, and raw data 
files. 

Export—send images to an export device. 

Information—display information about the active image file. This 
menu option has the same functionality as the Information toolbar 
button. 

Preferences—set 
your system parameters as follows: 

Units—pixels, inches, millimeters, centimeters 

Scratch Disk—choose a drive to use for temporary files 
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View Menu 
 

The View image menu allows you to manipulate image color with the 
following options: 

Color Simulation—manipulate image colors. When you check this 
menu option, the next option, Define Color Value, is activated. 
Define Color Value—assign new dot percentages. For how-to, see 
“Working With Color Values” on page 47. 

The View image menu also allows you to display or hide parts of the 
AIT interface with the following options: 

Main Toolbar 
Separation Toolbar 
Status Bar 

 

Last Acquire—invoke the most recently used acquire folder and file
type. This menu option has the same functionality as the Last Acquire 
toolbar button.

Last Export—invoke the most recently used export plugin. This 
menu option has the same functionality as the Last Export toolbar  
button. 

Exit—close the AIT application. 
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Setup Menu  
The Setup image menu is the same as the Setup main menu 
(page 36). 

Mode Menu 
 

The Mode image menu is the same as the Mode main menu 
(page 36). 

Measure Menu
 

The Measure menu options are inactive. 

Window Menu 
 

The Window menu uses standard WINDOWS NT functionality to 
display and organize multiple image files. 

Help Menu  
The Help menu displays AIT software version information, and has 
help topics available to provide online guidance using the AIT. 
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Starting the AIT 
To start or restart the AIT application, double-click the AIT desktop 

icon   

Closing the AIT 
CAUTION: Make sure no files are transferring and all proofing 

has been completed before exiting the AIT. 

Select Exit from the File menu to close the AIT application. 
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Proofing in Automatic (Hot Folder) Mode 

Proofing in Automatic (Hot Folder) Mode 
Automatic mode, also known as hot folder mode, is suitable for 
productive, unattended proofing. In automatic mode, proofing is 
activated by a trigger file (usually an .ini or .eps file) received from the 
RIP. 

In this mode, one or more hot folders must have been defined. (See 
“Setting Up Hot Folders” on page 21.) The sending RIP activates the 
session by generating the image files and putting them in the AIT input 
folder. These files then have hot folder proofing parameters applied. 

For operator workflows, see “Appendix C AIT Workflow 
Configurations” on page 133. 

 
1. Select Streamer and Plane by Plane from the 

Mode menu. 

These two modes provide the most efficient 
way to transfer files. 

2. (OPTIONAL) Select Show Export Setup from 
the Setup menu if you would like to view the 
proofing parameters of each file. 

NOTE: After you are satisfied that the settings 
are correct, you can turn off this feature 
to fully automate the process. 

3. Click the Activate Hot Folder button on the 
Main toolbar. 

The AIT begins automatic operation. 
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Proofing in Manual Mode 
Manual mode allows you to proof images without .ini files. In manual 
mode, you manually apply the proofing parameters to the images. 
When hot folders are not activated, the AIT is in manual mode. 

For operator workflows, see “Appendix C AIT Workflow 
Configurations” on page 133. 

 
 

 

1. Verify that the Activate Hot Folder button is not 
selected. 

2. Select Streamer and Plane by Plane from the
Mode menu. 
These two modes provide the most efficient 
way to transfer files. 

3. Select Show Export Setup from the Setup 
menu. 

 

4. Select File/Acquire/<file type>. 
The Open window appears. 
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Proofing in Manual Mode 

 

 

5. Select the CMYK TIFF separations or DCS2 
image you want to proof. 

6. Click Open. 
7. Select your output device from the Device 

Name drop-down list. 

 8. Check the proofing information and adjust the 
parameters for the file you are proofing. 
All proofing parameters are available in Manual 
mode, including Donor Mapping and Donor 
Laydown Order. 

9. Click OK to send the file to the KODAK 

APPROVAL device. 

The image appears in the main AIT window.
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Viewing and Manipulating Images 
Use Viewer mode to view and manipulate the following image types in 
the APPROVAL XP/XP4/NX host queue manager: 

� TIFF/.ini 
� TIFF 
� Raw data files 

You use the Separations Toolbar and options from the View menu to 
manipulate the images. 

1. Select Viewer from the Mode menu. 

2. Verify that Plane By Plane is not selected. 

3. Select PSik Null for export. 

4. Select File/Acquire/TIFF Bit-map, or from the 
Main Toolbar, click the TIFF bitmap button. 
The Open window appears. 
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5. Select the image you want to view, then click 
Open. 
The image appears in the main AIT window. 

6. Use the Separations Toolbar to 

�  View individual separations 
� Magnify the image to see any flaws in the 

dot screened bitmap 
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Working With Color Values 
You can assign new dot percentages to your displayed images 
(making the image darker or lighter) while you are in Viewer mode. 

1. From the Mode menu, check Viewer. 

2. Acquire your image. 

3. From the View menu, select Color 
Simulation. 

The Define Color Value menu item is 
activated. 

4. Select Define Color Value. 
The Color Simulation Table window appears. 
The current dot percentage is displayed in the 
text box for each separation. 

5. Double-click the color separation you wish to 
edit. 

The Color Simulation Setup window appears. 
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6. Assign a new dot percentage to the 
separations. 

7. Click OK. 

The change is displayed in the Color 
Simulation Table window.  

 

8. Click OK. 

The image is redrawn with your change 
applied. 
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Using Recipe Colors 
Use the Recipe Builder option on the Templates menu to define recipe 
colors. Recipe colors simulate spot color printing on a proof by 
combining several donors at varying densities to create unique solid 
colors. Spot colors are used when a color must be reproduced more 
accurately than is possible by using traditional CMYK donors. 

Setup Considerations 
To define new colors, create a recipe matrix using the Host Recipe 
Generator to approximate the new color. 
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Defining a Recipe Color 

 
1. Select Recipe Builder from the Templates 

menu. 
The Separation Parameters window appears. 

 
 

Viewing Box
 

2. Type a descriptive name in the Recipe Name 
text box, or select an existing name from the 
drop-down list. 

3. Select either Pantone or User Defined from 
the drop-down list. 

4. Use the CMYK text boxes to set the color 
simulation for screen viewing. In each text box 
enter a percentage of the donor color. 
NOTE: The viewing box changes to match the 

CMYK percentage entries. 
5. In the Order text boxes, select the donor colors 

that will be used to create the recipe color. 
6. In the Density text boxes, enter the density of 

each donor color based on the recipe matrix 
you created. 

7. (OPTIONAL) Select Use Media Savings for 
this specific Recipe Color. 

8. Click Update. 

The recipe color is saved in the AIT PANTONE 
or user-defined table. 
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9. Repeat steps 2 through 8 to define additional 
Recipe Colors if necessary. 
OR 
Click OK to exit Recipe Builder. 



 

 

Using AIT 

 47

Using Donor Colors 
Donor color functions within the AIT include: 
� Donor mapping 

� Donor laydown order 

Donor Mapping 
Donor mapping provides global substitution of donor colors for both 
process and recipe colors. Donor mapping templates are created and 
named, and then assigned to Hot Folders during the setup procedure. 
See “Setting Up Hot Folders” on page 21. 

 

1. Select Donors Mapping Template from the 
Templates menu. 
The Mapping of Donors window appears. 
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Using Donor Colors 

 
2. Type the following information in the Mapping 

area of the window: 
� Name — a descriptive name for this donor 

mapping template. 
� Description — text describing this 
template. 

3. For each of the Input Separations (CMYK), 
choose a Process and Recipe Mapped donor 
from the drop-down lists. 

4. Click Save. 
5. Click OK. 

A Donor Mapping template has been created 
and can now be specified during Hot Folder 
Setup. 
NOTE: If the RIP output is something other 

than CMYK, you can use the 6 blank 
mapping areas to map donors on your 
KODAK APPROVAL XP/XP4/NX 
device. 
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Donor Laydown Order 

 

 Donor laydown order specifies the order in which donor colors are applied 
to a proof. 

   1. Select Donors Laydown Order from the 
Templates menu. 
The Donor Laydown Order window appears. 

 

2. Type the following information: 

� Name — a descriptive name for this donor 
laydown order 

� Description — text describing this donor 
laydown order 

3. Click and drag the donor colors until they are 
listed in the order in which they should be 
applied to the proof. 

4. Click Save. 
5. Click OK. 

A Donor Laydown Order has been created and can 
now be specified during Hot Folder Setup.
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Using the Recipe Lists Manager 
The Recipe Groups Manager allows you to group recipes and save 
the group for reuse. For example, you might group all of the recipes 
used for a particular product, then select the group when needed. 

 

 
1. Select Recipe List Manager from the 

Templates menu. 
The Recipe Groups Manager window 
appears. 

2. Do any or all of the following: 

� Add a list (page 56) 
� Add recipes to a list (page 57) 
� Remove recipes from a list (page 
58) 
� Delete a list (page 58) 

3. Click OK. 
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Adding a List   

1. Click Add List. 

2. Type a descriptive name then click OK. 

The new list appears in the Edit List with a .txt
extension. It also appears in the list of source 
groups at the right of the window. 



 

 

Using AIT 

52

Adding Recipes to a  List  

1. Select a group from the Source List at the 
upper right of the window. 

2. Select one or more recipes from the Recipes 
list at the right of the window. 
NOTE: You can use the Ctrl or Shift key to 

select more than one recipe. 
NOTE: If you type the first letters of a recipe 

name, the first recipe (in alphabetical 
order) beginning with those letters 
appears. 

3. Click <<ADD. 

The recipes appear in the Recipes list at the 
left of the window. 
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Removing Recipes from a List  

1. Select a recipe from the Recipes list at the left 
of the window. 
You cannot remove recipes from the source 
group at the right of the window. 

2. Click Remove recipe. 
3. Click YES on the confirmation screen. 

NOTE: The recipe is removed from the edit 
group. It is not removed from the 
source group. 

Delet ing a List  
 

1. Select a group from the Edit Group list at the 
upper left of the window. 

2. Click Delete List. 

3. Click YES on the confirmation screen. 
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Using the Recipe Search Engine 

Using the Recipe Search Engine 
You can use the Recipe Search Engine to determine which groups 
contain a particular recipe. You can then use the group as a source 
when adding recipes to a group in the Recipe Group Manager (page 
57). 

 
 

 

1. Select Recipe Search Engine from the 
Templates menu. 
The Recipe Search Engine window appears. 

2. Type the name of the recipe you are searching 
for. 

All groups containing that recipe are listed. 
� Double-click Name, Group name, or File 

date to launch the Recipe Group template. 
� Double-click the color to display the 
Recipe 

densities. 
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Modifying an Output File 
Output files are originally saved from the graphics application (for 
example, ADOBE Illustrator) as .ps files. The RIP then saves them as 
.eps files. You can open and modify the .eps file in the AIT which then 
sends the information to the APPROVAL System as screened data. 

In Manual mode (page 42) you can modify output files and specify 
how an image is handled on the APPROVAL System. (You cannot 
modify output files in Automatic mode.) 

1. Select Show Export Setup from the Setup 
menu. 
NOTE: This must be checked for you to 

continue. 

2. Select Acquire from the File menu then select 
TIFF Bit Map or DCS. 
The WINDOWS Open dialog box appears. 

 

3. Navigate to and select the desired output file. Click OK. 

The Kodak Approval Setup window appears with the information from the 
selected output file. 
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4. Select the Input Colors view style. 

There are two view styles: 

� Input Colors—(shown here) displays the 
output file as generated by the RIP. You can 
make modifications in this view. 

NOTE: Unchecked input colors are not sent to 
the host. 

� Passes—displays the actual pass order that 
will go to the APPROVAL System. See 
“Viewing Pass Order” on page 67. After 
making modifications in Input Colors view, 
you should check the Passes view to assure 
that the laydown order is correct. 

IMPORTANT: If a color is not checked, you 
must make adjustments for the 
APPROVAL System to handle the 
color. See “Defining a Recipe Color” 
on page 50. 
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5. Make any or all of the following modifications. 

IMPORTANT: You must select the Recipe List, 
Donor Mapping and Donor Laydown 
Order before moving and locking input 
colors. You must lock a color after 
changing its order. 

� Select a cropping option (page 65). 
� Select a recipe list (page 66). 
� Select donor mapping (page 66). 
� Select donor laydown order (page 66) 
� Change the order of colors or donors 

(page 63). 
� Lock or unlock colors and donors (page 63). 
� Change a color field to a donor loaded in the 

APPROVAL System (page 63). 
� Change density (page 66). 
� Modify additional options (page 67). 
� View pass order (page 67). 

6. If necessary, select Media Saving. 
Media Saving must be checked for your 
modifications to take effect. 

7. Click OK. 



 

 

Using AIT 

58

Locking and Unlocking Colors and Donors 
You can lock colors and donors to assure their laydown order on the 
APPROVAL System. Locking assures that the laydown order is not 
changed for those colors or donors. 
 

 

1. Select a color or donor 

2. Click the right mouse button then 
make your selection: 

• Lock Input Color 
• Unlock Input Color 
• Lock Donors 
• Unlock Donors 

A lock icon appears next to a color or 
donor when it is locked 

 

Changing the Order of Input Colors 
If a color is not locked, you can drag it to a different position, 
changing its laydown order on the APPROVAL System. 

Changing a Color Field to a Donor Loaded in the 
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APPROVAL System 
If there is no donor loaded on the APPROVAL System for a color in 
the output file, you can change the color in the output file rather than 
loading a new donor. For example, if cyan is in the output file, but a 
DCO3 donor is loaded, you can change cyan to DCO3. 

 

Double-click a color, then select a donor that 
is loaded on the APPROVAL System. 
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Selecting a Cropping Option 
For oversized images you can select a cropping option. 

 

Select an option from the Cropping option 
drop-down list. 
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Selecting a Recipe List 
You can select a recipe group that the APPROVAL System can 
search for recipes. 

 

Select an option from the Recipe Group 
drop-down list. 

 

Selecting Donor Mapping 
You can select donor mapping, which substitutes donor colors for 
process and recipe colors. See “Donor Mapping” on page 52. 

Selecting Donor Laydown Order 
You can select a donor laydown order, which allows a specific 
laydown order to be applied to a particular job. See “Donor Laydown 
Order” on page 54. 

Changing Density 
You can change the density for a color. See “Creating a Template” on 
page 27. 

NOTE: The density must be within the range -99 to 99. 
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Additional Options 
You can change the offset units, the X and Y offsets, and the number 
of copies. 

Viewing Pass Order 
After you have made modifications in Input Colors view, you should 
check the Passes view to assure that the laydown order is correct. 
This view shows the actual order of passes that will be made by the 
APPROVAL System. 

 

Select the Passes view style. 
If additional changes are necessary, select the 
Input Colors view style, make additional 
changes, then select the Passes view style 
again to verify. 
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4 Using Rotation and Tiling 

This chapter describes how to use the KODAK APPROVAL Interface 
Toolkit (AIT) Rotation and Tiling feature. This feature is available only 
when AIT is installed on a dedicated PC and is automated through hot 
folder setup. 

Rotation and Tiling allows you to use the plate setter image when 
making proofs—even if the image size is larger than the proofing 
device’s maximum image size, 20" x 26" (50.8 cm x 66.04 cm). 

A rotation/tiling template is created and then applied to a hot folder. All 
jobs passing through an individual hot folder have the same 
rotation/tiling template applied. The rotation/tiling template defines the 
operations to be performed on the basic image data before proofing. 
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The AIT has three modes of operation: 

� Pass Through Mode—allows a job with the correct size and 
orientation parameters to pass through a rotation/tiling template 
hot folder directly to the KODAK APPROVAL host queue. Jobs 
with the correct size parameters that need rotation only are 
passed to the rotation/tiling results folder. From there these jobs 
are passed to the KODAK APPROVAL host queue using a 
second hot folder setup. 

� Dynamic Rotation/Tiling—allows the use of the same rotation/tiling 
template for jobs with varying plate sizes. Dynamic tiling is 
specified in the rotation/tiling template. Pass through mode is 
active even when dynamic rotation/tiling is selected. 

� Normal Rotation/Tiling—the rotation/tiling template is set up for a 
specific plate size. 
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System Specifications 

System Specifications 
AIT can be installed on a dedicated PC at your site with the following 
components and system configuration. It is designed to allow more 
than eight hours of unattended proofing. 

The components listed here comprise the current minimum system 
configuration. Installed component specifications are subject to 
change without notice. 

NOTE: It is recommended that the computer you select be listed in 
the MICROSOFT Hardware Compatibility List. Refer to the 
Microsoft Web site for more information. 

PC Minimum Requirements Specifications 
� Two 1.5 GHz (or greater) INTEL Xeon processors 

� 512 MB RDRAM 
� 2 36 GB SCSI hard disk drives 
� 2 10/100 Base-T ETHERNET Cards/Connections 
� Network crossover cables 

Software Specifications 
� MICROSOFT WINDOWS 2000 Professional Operating System 

with Service Pack 4 or MICROSOFT WINDOWS XP Operating 
System with Service Pack 2 

� KODAK AIT software and Dongle (HASP) for enabling AI software 

Communications 
The AIT communicates with the X P / X P 4 /N X  d ev i c es  using a TCP/IP 
network connection. 
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Using Rotation/Tiling Templates 
When working with Rotation and Tiling, keep in mind: 

� AIT Rotation and Tiling is performed on the all-current file 
formats. 

� When rotation is applied, it's always in the clockwise direction and 
90 degrees at a time. 

� Normal rotation/tiling templates use the upper left-hand corner as 
the origin point. 

� Dynamic rotation/tiling templates use the center as the origin 
point. 

� Offsets in height and width can be applied to the origin point. 

� Always apply the rotation/tiling template first and then determine 
if the image needs to be rotated. 

 
To start the AIT double-click the desktop icon . The main AIT 
screen appears. Begin your rotation and tiling procedures from this 
screen. 
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Defining a Rotation/Tiling Template 
See “Examples” on page 76 to help you determine which values to 
enter when creating a rotation/tiling template. 

 

1. From the Templates menu, select 
Rotation/Tiling Template. 
The Rotation/Tiling Template window 
appears. 

 

2. Type a Template Description and Template 
Name in the text boxes. 

3. Select the Rotate first check box to make 
the longer edge of the tile vertical. 

The job is rotated 90 degrees clockwise before 
the tiling calculation takes place.

4. Select the Tile check box to perform the 
tiling. 

5. Select the Allow rotation to minimize tiles 
check box if you prefer to have the 
application decide to rotate the image to 
minimize the number of tiles. 

6. Select the two check boxes to limit the tiles 
in height and width to specify the exact 
number of tiles you need. 
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7. Enter the appropriate Tiling Parameters: 

� Offset—select the units and then specify 
the height and width of the offset of the 
first tile from the top-left corner of the job. 

� Tile Size—select the units and then define 
the height and width of each tile; this can 
be smaller than or equal to the proofing 
device’s maximum imaging area. 

� Gap—select the units and then specify 
the height and width of the gap between 
the tiles. 

NOTE: Specifying a negative number for the gap allows overlap between the tiles. 

8. Click Save. 
The Rotation/Tiling template is saved with 
the name entered in the Template Name 
text box. 

9. Click OK. 

The Rotation/Tiling Template window 
closes. 
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Applying a Rotation/Tiling Template to a Hot Folder 
Once you have created rotation/tiling templates, they must be applied to 
a hot folder using the Hot Folder Setup window. For more information, 
see “Setting Up Hot Folders” on page 21. 

1. In the Hot Folder Setup window, select the 
Output tab. 

2. Select Active in the Tiling box. 

3. From the drop-down list, select the 
Rotation/Tiling template to be used by this 
hot folder. 
Select the folder where the rotation and 
tiling results will be placed. 

NOTE: Donor mapping and donor laydown 
order must be synchronized with the hot folder 
used to transfer all jobs from the results 
rotation/tiling folder to the KODAK APPROVAL 
System. 

5. Click OK. 
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Examples 
Use the information in the following Rotation/Tiling schemes when 
you are customizing templates in the Rotation/Tiling Template 
window. These examples include landscape, portrait, and dynamic 
Rotation/Tiling schemes and their results. 

 

Landscape Rotation/Til ing Scheme 
If the file is in the landscape orientation, in most cases the file is not 
rotated as long as the height of the image area is less than 26". 

The following example demonstrates how to create a proof from a 
landscape plate that is 28" x 40". 
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Determine the image area. The image area is the actual size of the 
image. In the above example the image area is approximately 24 1/4" 
x 36 1/4". 

With the image area starting 3 3/16". 

Cut 2" from the top edge of the plate to fit the APPROVAL Slow Scan 
dimension of 26" This can be accomplished by applying a 2" offset in 
height. 

The width dimension is exactly double the APPROVAL Fast Scan 
dimension, so the tile size in width can be 20" No offset in width is 
needed. 

A gap or overlap can be applied to the tiles depending on the image. 
There are 8 separate elements on this image with a gap down the 
middle of the image. A gap could be applied but is not necessary for 
this tiling scheme. If the image is continuous, an overlap can be 
applied for splicing the two tiles back together. See “Gaps” on page 90. 
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Use the following values when creating the example Rotation/Tiling 
scheme: 

Value Input 

Rotate First Not Checked 

Tile Checked 

Dynamic Tiling Not Checked 

 Height Width 

Offset 2" 0" 

Tile Size 26" 20" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 1 2 



 

 

Examples

 73 

  

These values result in two identical tiles both with dimensions of 20 x 
26". 
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Portrait Rotation/Tiling Scheme 
If: 
� the file is in a Portrait orientation 
� the image area width is more than 20" or less than 26" 
� the height is more than 20" 

Then rotation and tiling are necessary for this tiling scheme. 

The following example demonstrates how to create a proof from a 
portrait plate that is 28" x 40". 
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Determine the image area. In the previous example the image area is 
approximately 24 1/4" wide x 36 1/4" high. 

With the image area starting 9/16" from the left margin and the image 
area plus left margin being less than 26" in width, no offset in width is 
needed. 

The height dimension is exactly double the APPROVAL Fast Scan 
dimension, so the tile size in height can be 20". No offset in height is 
needed. 

There are eight separate elements on this image with a gap down the 
middle of the plate. A gap could be applied but is not necessary for this 
Rotation/Tiling scheme. See “Gaps” on page 90. 

Use the following values when creating the example Rotation/Tiling 
scheme: 

Example of Portrait Rotation/Tiling Scheme Values 

Value Input 

Rotate First Checked 

Tile Checked 

Dynamic Tiling Not Checked 

 Height Width 

Offset 0" 0" 

Tile Size 20" 26" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 2 1 



 

 

Using Rotation and Tiling 

76

These values result in two identical tiles of 20" x 26". Remember the portrait Rotation/Tiling 
scheme rotates the tile clockwise 90 degrees. 
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Proofing a Single Tile 
If the elements on the image are the same, you can set up a 
Rotation/Tiling scheme to proof just the first tile instead of both tiles. 

To proof just one tile, set the "Limit # of tiles in" parameter in height 
and width to 1. This works for both landscape and portrait 
Rotation/Tiling schemes. 

Based on the examples used previously, the values for a single tile 
landscape scheme are: 

Example of Single Tile Landscape Scheme 

Value Input 

Rotate First Not Checked 

Tile Checked 

Dynamic Tiling Not Checked 

 Height Width 

Offset 2" 0" 

Tile Size 26" 20" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 1 1 
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The values listed in the previous table produce the following result: 
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For a single tile portrait Rotation/Tiling scheme use the following 
values: 

Example of Single Tile Portrait Scheme 

Value Input 

Rotate First Checked 

Tile Checked 

Dynamic Tiling Not Checked 

 Height Width 
Offset 0" 0" 

Tile Size 20" 26" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 1 1 
 

These values produce the following results. 

 
Remember the portrait Rotation/Tiling scheme rotated the tile 
clockwise 90 degrees. 
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Dynamic Rotation/Tiling Scheme 
Dynamic Rotation/Tiling can be used to create proofs from plates 
between 20" x 26" and 26" x 40". Dynamic Rotation/Tiling tiles from 
the center out. The Offset feature is not allowed, but Gaps and 
Overlaps are allowed. Separate dynamic Rotation/Tiling schemes 
must be used for landscape and portrait proofs. 

Landscape Dynamic Rotation/Tiling 

The values listed in the table below allow the four Rotation/Tiling 
examples to be tiled through the same hot folder. 

NOTE: Use the largest tile size when defining dynamic 
Rotation/Tiling schemes. 

Example of Landscape Dynamic Rotation/Tiling Scheme Values 

Value Input 

Rotate First Not Checked 

Tile Checked 

Dynamic Tiling Checked 

 Height Width 

Tile Size 26" 20" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 1 2 
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Using the previous Rotation/Tiling scheme values, the size of the two 
tiles for a 23" x 29" plate is 14.5" x 23". 

Plate Size 23x29 Top Margin 1 1/2" 

Using the previous Rotation/Tiling scheme values, the size of the two 
tiles for a 26" x 35" plate is 17.5" x 26". 

Plate Size 26x35 Top Margin 3 3/4" 

 

20" 13 1/2" 20" 13 1/2" 

 

Left Margin 3/4" Right Margin 3/4" 

Bottom Margin 1 1/2" 

  1/2" 

24" 16 1/4" 24" 16 1/4" 

 

Left Margin 1" Right Margin 1" 

Bottom Margin 3" 
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Using the previous Rotation/Tiling scheme values, the size of the two 
tiles for a 25" x 38" plate is 19" x 25". 

P l a t e  S i z e  2 5 x 3 8  

 

Using the previous Rotation/Tiling scheme values, the size of the two 
tiles for a 26" x 40" plate is 20" x 26". 

P l a t e  S i z e  2 6 x 4 0  
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Portrait Dynamic Rotation/Tiling 

If all of the previous examples are in the portrait orientation, the 
Rotate First feature must be checked, and the tile size parameter 
Height and Width must be swapped. The example tiling results are 
the same. 

Example of a Portrait Dynamic Rotation/Tiling Scheme 

Value Input 

Rotate First Checked 

Tile Checked 

Dynamic Tiling Checked 

 Height Width 

Tile Size 20" 26" 

Gap/Overlap 0" 0" 

Limit # of Tiles in 1 2 
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G a p s  
The gap parameters are for adding space between elements of an 
image. 

If: 
� the file is in a portrait orientation 
� the image area width is 26" or less 
� the height is more than 20" 

Then rotation and tiling are necessary. 

The following example demonstrates how to use the gap parameter 
with a portrait plate that is 25" x 36": 

 Plate Size 25" x 36"  

Top Margin 1" 

Left Margin 1" 

First Tile 

1/4" Gap 

Second Tile 

Right Margin 1" 

Bottom Margin 1" 
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Determine the Image Area. In the previous example the Image Area is 
approximately 23" wide x 34" high. 

With the width of the tile being less than 26", no offset in width is 
needed. The height dimension is more than 20"; so the image needs 
to be tiled. 

A tile size in height of 17 1/2" is used. No offset in height is needed 
because the tiles is less than 20" in height. Rotation is required 
because the width dimension is more than 20". The two elements in 
the image are 1/4" apart so a 1/2" gap must be added between the 
two tiles at the center of the plate. 

Use the following values when creating the example Rotation/Tiling 
scheme: 

Example of Rotation/Tiling Tiles with Gaps 

Value Input 

Rotate First Checked 

Tile Checked 

 Height Width 

Offset 0" 0" 

Tile Size 17 1/2" 25" 

Gap/Overlap 1/4" 0" 

Limit # of Tiles in 2 1 
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The values from the table produce the following results: 

 

 

 

 

  

 The gap parameter removed 1" from the center tile. 
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Overlaps 
The overlap parameter (expressed as a negative number in the gap 
parameter of the tiling template) is generally used for large and 
continuous images that are larger than the A P P R O V A L  output size. 
These large continuous images must be tiled before they can be 
spliced together and proofed. 

If: 
� the file is in a portrait orientation 
� the image area width is 20" or more 
� the height is more than 26" 

Then rotation and tiling are necessary for this tiling scheme. 

The following example describes how to use the overlap parameter 
with a portrait plate that is 25" x 36". 
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Determine the image area. In the previous example the image area is 
approximately 23" x 34". Because the image area width dimension is 
more than 20", rotation is required. 

With the plate width being less than 26", no offset in width is required. 
The height dimension is more than 20" so the image needs to be tiled. 
A tile size in height of 18" is used. No offset in height is required 
because the tiles are less than 20" in height. 

The image on the plate is continuous, so an overlap can be specified in 
the gap parameter using a negative number instead of a positive. A 1/4" 
overlap is used for this example. 

The following values are used for this example. 

Example of Rotation/Tiling Tiles with Negative Gaps (Overlaps) 

Value Input 

Rotate First Checked 

Tile Checked 

 Height Width 

Offset 0" 0" 

Tile Size 18" 25" 

Gap/Overlap -1/4" 0" 

Limit # of Tiles in 2 1 
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These values produce the following results: 

 

The second tile starts 1/4" into the first tile creating the overlap. Now 
the second tile contains 1/4" of the first tile plus 17 3/4" of the second 
tile. 

If the tile size is the same as the A P P R O V A L  output size and overlap is 
needed, part of the image on the second tile opposite of the overlap 
may be missing. This is because the tile size is not large enough to 
capture part of the first tile (overlap) and the entire second part of the 
image. 

Now the two tiles can be spliced together by overlapping the two tiles by 
1/4" and cutting down the center of the overlap. 
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5 Troubleshooting 

If you have a problem with the KODAK APPROVAL Interface Toolkit, 
you need to determine which part of the system may be causing the 
problem. This chapter helps you determine where the problem 
originates, and what to do about it. 

Getting Help 
If you cannot solve your AIT problem with the troubleshooting tips in 
this chapter, call your AIT service provider at: 1-877-KPGRAPHICS (1-
877-574-7274), using prompts 2, 7, and 2. 
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Files Not Transferring to the Queue Manager 
1. Verify that the Hot Folder toolbar button is active. 

Hot Folder toolbar button 

2. Look in the Hot Folders Setup window to verify that the check box 
for the appropriate Hot Folder is selected. 

 
3. Verify the information in the Hot Folder Setup window. See “Hot 

Folder Setup” on page 22. 

� Is the RIP output folder specified correctly? 
� Is the Input Plugin set correctly (Tiff BM or DCS2)? 
� Is the correct file type selected to activate the hot folder (Tiff 

BM files use*.ini or DCS2 files use *.eps)? 
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Files Not Transferring to the Queue Manager 

4. Make the necessary changes. 

RIP output folder 

File to activate the 
folder 
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KODAK APPROVAL XP/XP4/NX Host 
Application Not Launched 

The following error appears if the host application is not launched or 
the AIT PC loses the network connection to the KODAK APPROVAL 
XP/XP4/NX host. Use the Approval Device Type Wizard to verify the 
correct IP address of the Host. 

 
1. Click Cancel. 
2. Launch the KODAK APPROVAL XP/XP4/NX host application. 
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Hot Folders Active With Streamer/Viewer Mode Selected 

Hot Folders Active With Streamer/Viewer 

Mode Selected 
The following error appears when Hot Folder mode is active, but only 
the Streamer mode or Viewer mode are selected: 

 

1. From the Mode menu in the AIT window select both Streamer 
mode and Plane By Plane. 

 
Activate Hot Folder Button 
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Pantone List Missing or Color Undefined 
The following error appears when the Pantone list is missing, or the 
Pantone or recipe color has not been defined. 

 
1. Check C:\AIT\Psik\Tables folder for the file PantoneRecipes.txt. 
2. Click OK and define the recipe. 

TIFF Separation Missing 
The following error appears when the separation file is missing or 
corrupted. 

 

1. Deactivate the hot folder mechanism. 

2. Delete all files in the Input, Done, and Error folders. 

3. Activate the hot folder mechanism. 

4. Re-RIP the job. 
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Input Donor Colors Not Mapping Correctly 

Input Donor Colors Not Mapping Correctly 
When the input donor color names are not mapping correctly to the 
output donor color names, verify that donor mapping is activated in 
the Hot Folder Setup, and that the correct Donor Laydown order is 
selected. For more information on hot folder setup, see “Setting Up 
Hot Folders” on page 21. 
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Donor Laydown Order Not Correct or Template 

Missing 
The following error occurs when the donor laydown order template is 
missing: 

 

Take the following steps: 

1. Verify that the correct donor laydown order template was selected in 
the Hot Folder Setup. 

 

Donor laydown order information 



 

 

Donor Laydown Order Not Correct or 
Template Missing 

2. Verify that the laydown order is correct 
in the specified template. 

 



 

 

6 Backup and Restore 

This chapter provides instructions for using the Backup_Restore utility 
to back up and restore the KODAK APPROVAL Interface Toolkit 
configuration files, setup files and input folders. You can back up files to 
or restore them from the network or a floppy diskette. 

Backing Up AIT Files 
 

1. If necessary, insert the floppy 
diskette that will store the backed 
up files. 

2. From the WINDOWS Start menu 
select Programs>AIT 
3.1>Backup_Restore. 
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3. Click Backup. 

The Browse window appears. 

 

4. Select the floppy diskette or network 
location on which the files will be stored. 

5. Click OK. 

The AIT Backup/Restore window appears 
and the progress of the backup appears in 
the status portion of the window. 

 

6. Click OK when the Backup Complete 
message appears. 
The AIT files are saved to the selected 
location and the AIT Backup/Restore 
window closes. 
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Restoring AIT Files 

 

Restoring AIT Files
 

 1. If necessary, insert the floppy diskette 
that contains the files to restore. 

2. From the WINDOWS Start menu 
select Programs>AIT 
3.1>Backup_Restore. 

3. 3. Click Restore. 

 
The Browse window appears. 

 

 

4. Select the floppy diskette or network 
location from which to restore the files. 

5. Click OK. 

The AIT Backup/Restore window appears 
and the progress of the restore appears in 
the status portion of the window. 



 

 

Backup and Restore 

102

 

 

6. Click OK when the Restore Complete 
message appears. 
The AIT files have been restored from the 
selected location and the AIT 
Backup/Restore window closes. 



 

 

Troubleshooting 

Troubleshooting 
The following errors appear when you are backing up or restoring and 
the network connection has been lost. 

 
1. Verify that the system is active. 

2. Remap the drive if necessary. 



 

 

Appendix A 

Installing AIT 

AIT installation consists of installing a dongle on the PC, and then 
installing the software application. This appendix provides the 
procedures for installing the AIT on either the Host or a separate PC. 

Installing a Dongle 
Depending on the type of dongle, you can install the dongle in a 
Parallel or USB port. 

CAUTION: The dongle must remain connected to the HOST or 
dedicated PC when the AIT application software is 
active. 
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Installing a Dongle on a Parallel Port 
Install the dongle on the parallel port of the PC, and then hand-tighten 
the thumbscrews. 

 
D o n g l e  

 
  

Installing a Dongle on a USB Port 
Install the dongle on the USB port of the PC. 
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Installing the AIT Software on the Host 
1. Start the Host PC and log on as 

Administrator. 

2. Insert the AIT software CD into the 
CD ROM drive. 

3. Open Explorer and navigate to the AIT CD. 

4. Double-click on the file: 

AIT\AIT 31.exe 
The Extracting Files window appears to show the 

progress of the file extraction. 

NOTE: Click Cancel at any time to stop the 
installation. 

When the files have been extracted, the AIT 
Version window and the InstallShield Wizard 
window appear. 

5. Click Next. The Customer Information 

window appears. 
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6. Enter the User Name and Company Name 
in the text boxes. 

7. Click Next. 

The Device and Location Information 
window appears. 

 

8. Verify the model of the KODAK APPROVAL 
XP/XP4/NX device to which you will be 
connecting. 

9. Click Yes. 

The Choose Destination Location window 
appears. 

10. Click Browse. 

The Choose Folder window appears. 
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11. Browse to C:Program Files. 

12. Add the folder \AIT. 

 

13. Click OK. 

The new folder appears as the Destination
Folder in the Choose Destination Location 
window. 

 

 

14. Click Next. 

The Setup Type window appears. 
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15. Click Next. 

The Start Copying Files window appears. 

 

16. Click Next. 

The Setup Status window appears with a 
status bar to show the progress of the load 
procedure. 

Upon completion of the software load, the 
HASP window appears. 
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17. Click Yes. 

The status window appears briefly, and then 
the completion window appears. 

 

18. Click OK. 

The Installing Hasp window appears, 
asking if you want to restart the system. 

 

19. Click Finish. 

The System restarts. 
20. Log on to the system as the APS user. 

The first time you log on after installation, 
the RIP ID Font window opens. 

21. Launch the KODAK APPROVAL software. 

 

22. Click OK. 

This launches the APPROVAL Device Type 
Wizard. See “Defining the Device Setup” on 
page 17. 
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Installing the AIT Software on a Separate PC 
1. Start the PC and log on. 

2. Insert the AIT software CD into the 
CD-ROM drive. 

3. Open Explorer and navigate to the AIT CD. 

4. Double-click on the file: 

AIT\AIT 31.exe 
The Extracting Files window appears to show the 

progress of the file extraction. 

NOTE: Click Cancel at any time to stop the 
installation. 

When the files have been extracted, the AIT 
Version window and the InstallShield Wizard 
window appear. 

5. Click Next. The Customer Information 

window appears. 
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6. Enter the User Name and Company Name 
in the text boxes. 

7. Click Next. 

The KODAK APPROVAL Digital Proofer 
Model Selection window appears. 

8. Select the model of the KODAK APPROVAL 
XP/XP4/NX device to which you will be 
connecting. 

9. Click Next. 

The AIT Location window appears. 
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10. Select A separate PC. 
11. Click Next. 

The Choose Destination Location 
window appears. 

 

12. Click Next. 

The Choose Folder window appears. 

 

13. Browse to C:Program Files. 

14. Add the folder \AIT. 
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15. Click OK. 

The new folder appears as the Destination
Folder in the Choose Destination Location
window. 

 

16. Click Next. 

The Setup Type window appears. 

 

17. Click Next. 

The Start Copying Files window appears. 
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18. Click Next. 

The Setup Status window appears with a 
status bar to show the progress of the load 
procedure. 

Upon completion of the software load, the 
HASP window appears. 

 

 

20. Click OK. 

The Installing Hasp window appears, 
asking if you want to restart the system. 

 19. Click Yes. 

The status window appears briefly, and then 
the completion window appears. 



 

 

 
21.Click Finish. 

The System restarts. 
22. Log on to the system as the Administrator.

The first time you log on after installation, 
the RIP ID Font window opens. 

23. Make sure the KODAK APPROVAL 
software is up and running. 

 

24. Click OK. 

This launches the APPROVAL Device Type
Wizard. See “Defining the Device Setup” on
page 17. 
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Proofing Parameter Files 
The following pages contain examples of proofing parameter files: 

� .ini 

� modified .ini (two examples) 

� template.txt 

NOTE: These examples are for reference only. 
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Example of an .ini File 
[general] 
VersionNumber=3. 00 
NumberOfSeparations=4 
XPosition=0 
YPosition=0 
Copies= 1 
FastScanSize=2 0416 
SlowScanSize=2 6400 
Resolution=2400 
MediaSavingFlag= 0 
[DonorMapping] 
Donor1=EuroCyan 
TransparencyDonor1=1 

OrderOfDonor1=1 Donor2 
=Magenta 
TransparencyDonor2 =1 
OrderOfDonor2 =2 
Donor3=Yellow 
TransparencyDonor3 =1 

OrderOfDonor3 =3 
Donor4=Black 
TransparencyDonor4 =1 
OrderOfDonor4=4 

1 

FileName=E: \APPROVAL_out\Spotcolor_tile_test_qxd0_1. fcy 
SeparationName=Cyan 
DonorNr=1 
RecipeColor=0 
DensityDonor1=2 
ScreenRuling=143 
Angle=1 5 
Speed= 0 
. 
. 
. 

The file continues with information for the remaining separations. 

[ ] 



 

  119 

Example 1 of a Modified .ini File 

Example 1 of a Modified .ini File 
[general} 
VersionNumber=3. 00 
NumberofSeparations= 6 
Copies= 1 
FastScanSize=9 600 
SlowScanSize=9 600 
Resolution=2400 
Creator=agfa 

[1]  FileName=sixSeps_124__1_Front_Cyan. 
tif 
SeaparationName=Cyan 
[2]  FileName=sixSeps_124__1_Front_Magenta. 
tif SeparationName=Magenta 

[3]  FileName=sixSeps_124__1_Front_Yellow. 
tif 
SeparationName=Yel low 
[4]  FileName=sixSeps_124__1_Front_Black. 
tif 
Separat ionName=Black 
[5]  FileName=sixSeps_124__1_Front_AdobeGreen. 
ti f 
Separat ionName=AdobeGreen 
[ 6} 
FileName=sixSeps_124__1_Front_AgfaOrange. ti f 
SeparationName=AgfaOrange 
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Example 2 of a Modified .ini File 
[general] 
VersionNumber=3.00 
NumberOfSeparations=4 
Copies= 1 
FastScanSize=20400 
SlowScanSize=26399 
Resolution=2400.00 
Creator=DSEA 

[1]  
FileName=DSTF_C.TIF 
SeparationName=Cyan 
ScreenRuling=150 
Angle=1 5 
[2]  
FileName=DSTF_K.TIF  
SeparationName=Black 
ScreenRuling=150 
Angle=75 
[3]  
FileName=DSTF_M.TIF 
SeparationName=Magenta 
ScreenRuling=150 
Angle=45 
[4]  
FileName=DSTF_Y.TIF  
SeparationName=Yellow 
ScreenRuling=150 
Angle=0 



 

 

Example of a Template .txt File 

Example of a Template .txt File 
[general} 
VersionNumber=3. 00 
NumberofSeparations=16 
XPosition=0 
YPosition=0 
Copies= 1 
Resolution=2 540 
MediaSavingFlag=1 
DeviceName=Approval XP4 2540 
AITDonorMappingName=default.txt 
UseAITLaydownOrder= 0 
DeleteOnSuccess= 0 
DeleteOnError=0 
SuccessMoveDir=E: \input_150\Done 
ErrorMoveDir=E: \input_150\Error 
[DonorMapping] 
Donor1=Cyan 
TransparencyDonor1=1 
OrderOfDonor1=1 
Donor2 =Magenta 
TransparencyDonor2 =1 
OrderOfDonor2 =2 
Donor3=Yellow 
TransparencyDonor3 =1 
OrderOfDonor3 =3 
Donor4=Black 
TransparencyDonor4 =1 
OrderOfDonor4=4 
Donor5=Fifth 
TransparencyDonor5=1 
OrderOfDonor5=5 
Donor6=Sixth 
TransparencyDonor6 =1 
OrderOfDonor6=6 
[1} 
FileName= 
SeparationName=Cyan 
RecipeColor=0 
Density=0 
ScreenRul ing=1 50 



 

 

Angle=1 5 
Speed= 0 
[2]  
FileName= 
SeparationName=Magenta 
RecipeColor=0 
Density=0 
ScreenRul ing=1 50 
Angle=7 5 
Speed= 0 
[3]  
FileName= 
SeparationName=Yel low 
RecipeColor=0 
Density=0 
ScreenRul ing=1 50 
Angle= 0 
Speed= 0 
[4]  
FileName= 
Separat ionName=Black 
RecipeColor=0 
Density=0 
ScreenRul ing=1 50 
Angle =45 
Speed= 0 
[5]  
FileName= 
SeparationName=Recipe1 
RecipeColor=1 
Density=0 
ScreenRul ing=1 50 
Angle =45 
Speed= 0 
. 
. 
. 

The file continues with information for the remaining separations. 
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Appendix C 

AIT Workflow Configurations 

This appendix contains tables that explain the steps required to 
configure AIT for various workflows. Each table includes references to 
appropriate procedures within this manual. The workflows are defined by 
the files supplied by the RIP, and include the following: 

� TIFF/.ini 
� Modified TIFF/.ini 
� DCS2 

In addition, a workf low for the Rotation and Tiling feature is also 
included. This workflow applies to all file types that use a tiling 
scheme. 

These workflows apply to an AIT installed on the KODAK APPROVAL 
XP/XP4/NX host. For information on installing AIT on the host see 
“Installing the AIT Software on the Host” on page 115. 
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TIFF/.ini File Workf low Configuration 
The AIT accepts the following one-bit TIFF file formats: 

� Uncompressed 
� Group 3 compressed 
� Pack Bit compressed 

NOTE: All recipe color parameter information is included in 
the .ini file. 

See “Example of an .ini File” on page 128. 

Steps Reference 

1. Preliminary setup:  
NOTE: We highly recommend using 

a second network card in the 
RIP computer and a 
crossover cable between the 
host and RIP computers. 

 

Power up the APPROVAL 
XP/XP4/NX host and log on as 
Administrator 
Set the APPROVAL XP/XP4/NX 
host 
IP Address to 192.168.0.1 and the 
RIP’s second network card IP 

Address to 192.1 68.0.2 
NOTE: Get the proper ID from your 

local network administrator. 
Establish network communication 
between the RIP and the 

APPROVAL XP/XP4/NX host 
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Steps Reference 

2. Create the RIP output folders on the 
RIP computer. The RIP uses these 

folders to output files, and these same 
folders are used as the AIT input 
folders. This procedure is usually 

performed by the RIP vendor. 

 

3. Install the Dongle and AIT software in 
the C:\Program Files\AIT folder 

See “Installing the AIT Software on the 
Host” on page 115. 

4. Start the APPROVAL XP/XP4/NX 
host software. 

5. Start the AIT application. 
 

6. Select Streamer and Plane By Plane 
from the Mode menu. 
 

 

 

7. Create donor laydown order 
templates. 
NOTE: These templates are applied

during hot folder setup. 

 

See “Donor Laydown Order” on page 54. 

8. Create donor mapping templates. 
NOTE: These templates are applied 

during hot folder setup. 

See “Donor Mapping” on page 52. 
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Steps Reference 

9. Set up and activate the hot folders. 
The AIT is now ready to transfer to the 
APPROVAL XP/XP4/NX host via 
OFE. 

See “Setting Up Hot Folders” on page 21. 

10. Enter a test file or copy a test file into 
the input folder. Remember to copy 
the separations before copying the .ini 
file. Once all files are in the input 
folder, the AIT waits 5 seconds before 
the job starts transferring. 
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 Steps Reference 

14. When the transfer starts, the AIT 
Preview window displays the first 
color separation a line at a time. 

 

16. Check the A P P R O V A L  XP/XP4/NX 
host queue manager to verify that the 
job is being transferred. 

The AIT is now configured and ready 
to proof TIFF/.ini files. 
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Modified TIFF/.ini File Workf low Configuration 
The AIT accepts the following one-bit TIFF file formats: 

� Uncompressed 
� Group 3 compressed 
� Pack Bit compressed (recommended) 

NOTE: To set up for a modified TIFF/.ini workflow, you must create a 
template.txt file for the AIT input folder. Template.txt files are 
used to set the ruling, density, and angles. Recipe color 
parameters come from the list of Pantone and user-defined 
recipes the AIT uses. 

The modified .ini file includes the following parameters: 

� Number of separations 
� Fast Scan size in pixels 
� Slow scan size in pixels 
� Resolution 
� Type of RIP that created the file 
� File name 
� Separation name 

See “Example 1 of a Modified .ini File” on page 129. 
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 Steps Reference 

1. Preliminary setup:  

 

NOTE: It is highly recommended to 
use a second network card in 

the RIP computer and a 
crossover cable between the 

host and RIP computers. 

 

 

Power up the APPROVAL 
XP/XP4/NX host and log on as 
Administrator 
Set the APPROVAL XP/XP4/NX 
host 
IP Address to 192.168.0.1 and the 
RIP’s second network card IP 
Address to 192.1 68.0.2 

 

 
NOTE: Get the proper ID from your 

local network administrator.  

 
Establish network communication 
between the RIP and the 
APPROVAL XP/XP4/NX host 

 

2. 
Create the RIP output folders on the 
RIP computer. The RIP uses these 
folders to output files, and these same
folders are used as the AIT input 
folders. This procedure is usually 
performed by the RIP vendor. 

 

3. Install the Dongle and AIT software in 
the C:\Program Files\AIT folder 

See “Installing the AIT Software on the 
Host” on page 115. 

4. Start the APPROVAL XP/XP4/NX 
host software. 

5. Start the AIT application. 
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Steps Reference 

6. Select Streamer and Plane By Plane 
from the Mode menu. 
 

 

 

7. Create donor laydown order 
templates. 
NOTE: Under the output tab, these 

templates are applied during 
hot folder setup. 

See “Donor Laydown Order” on page 54. 

8. Create donor mapping templates. 
NOTE: These templates are applied 

during hot folder setup. 

See “Donor Mapping” on page 52. 
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Steps Reference 

9. Set up and activate the hot folders. 

The AIT is now ready to transfer to the 
APPROVAL XP/XP4/NX host via 
OFE.

 
 

The Specific Input Plugin should be 
TIFF BM. 
 
The input trigger file type extension 
should be *.ini for Tiff BM 

See “Setting Up Hot Folders” on page 21. 
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Steps Reference 

10. Create a template.txt file to apply to 
the AIT input folder. 

See “Creating Templates” on page 26. 

NOTE: The template.txt file is used to 
set the ruling, density, angles 
X and Y offset, number of 
copies, and media savings. 
During hot folder setup the 
RIP’s drive that was shared 
will be automatically mapped 
on the APPROVAL 
XP/XP4/NX host. 

 

11. Enter a test file or copy a test file into 
the input folder. 

NOTE: Remember to copy the 
separations before copying the 
.ini file. Once all files are in the 
input folder, the AIT waits 5 
seconds before the job starts 
transferring. 
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 Steps Reference 

15. When the transfer starts, the AIT 
Preview window displays the first 
color separation a line at a time. 

17. Check the APPROVAL 
XP/XP4/NX host queue manager to 
verify that the job is being transferred. 

The AIT is now configured and ready 
to proof modified TIFF/.ini files. 
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DCS2 File Workflow Configuration 
The AIT accepts the following single DCS2 file formats: 

� RLE compressed (recommended) 
� Pack Bit compressed (recommended) 

NOTE: To set up for a DCS2 workflow, you must create a template.txt 
file for the AIT input folder. Template.txt files set the ruling, 
density, and angles. Recipe color parameters come from the list 
of Pantone and user-defined recipes the AIT uses. 

Steps Reference 

1. Preliminary setup:  
NOTE: We highly recommend using 

a second network card in the 
RIP computer and a 
crossover cable between the 
host and RIP computers. 

 

Power up the APPROVAL 
XP/XP4/NX host and log on as 
Administrator 
Set the APPROVAL XP/XP4/NX 
host IP Address to 192.1 68.0.1 and 

the RIP’s second network card IP 
Address to 192.1 68.0.2 

NOTE: Get the proper ID from your 
local network administrator. 

Establish network communication 
between the RIP and the 

APPROVAL XP/XP4/NX host 
NOTE: Sometimes a user account for 

the RIP computer will need to 
be added to the APPROVAL 

XP/XP4/NX host 
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Steps Reference 

2. Create the RIP output folders on the 
RIP computer. The RIP uses these 

folders to output files, and these same 
folders are used as the AIT input 
folders. This procedure is usually 

performed by the RIP vendor. 

 

3. Install the Dongle and AIT software in 
the C:\Program Files\AIT folder 

See “Installing the AIT Software on the 
Host” on page 115. 

4. Start the APPROVAL XP/XP4/NX 
host software. 

5. Start the AIT application. 
 

6. Select Streamer and Plane By Plane 
from the Mode menu. 
 

 

 

7. Create donor laydown order 
templates. 
NOTE: These templates are applied

during hot folder setup. 

 

See “Donor Laydown Order” on page 54. 

8. Create donor mapping templates. 
NOTE: Under the Output tab, these 

templates are applied during 
hot folder setup. 

See “Donor Mapping” on page 52. 
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Steps Reference 

9. Set up and activate the hot folders. 
The AIT is now ready to transfer to the 
APPROVAL XP/XP4/NX host via 
OFE. 

 
 

The Specific Input Plugin should be 
DCS2. 
 
The input trigger file type extension 
should be *.eps for DCS2 

See “Setting Up Hot Folders” on page 21. 
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Steps Reference 

10. Create a template.txt file to apply to 
the AIT input folder. 

See “Creating Templates” on page 26. 

NOTE: The template.txt file is used to 
set the ruling, density, angles 
X and Y offset, number of 
copies, and media savings. 
During hot folder setup the 
RIP’s drive that was shared 
will be automatically mapped 
on the APPROVAL XP/XP 
host. 

 

11. Enter a test file or copy a test file into 
the input folder. 

NOTE: Remember to copy the 
separations before copying the 
.ini file. Once all files are in the 
input folder, the AIT waits 5 
seconds before the job starts 
transferring. 
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 Steps Reference 

15. When the transfer starts, the AIT 
Preview window displays the first 
color separation a line at a time. 

17. Check the APPROVAL XP/XP4/NX 
host queue manager to verify that the 
job is being transferred. 

The AIT is now configured and ready 
to proof TIFF/.ini files. 
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Rotation and Tiling Workflow Configuration 
The rotation and tiling workflow configuration is the same for the 
following file types: 

� TIFF/.ini 
� Modified TIFF/.ini 

� DCS2. 

Steps Reference 

1. Preliminary setup:  

NOTE: We highly recommend using a 
second network port in the RIP 
computer. Also, use crossover 
cables between the rotation and 
tiling PC and RIP computer, and 
between the rotation and tiling 
PC and the host. 

 

• Power up the rotation and tiling PC 
and log on as Administrator. 

• Based on the recommended 
preliminary setup, verify the IP 

 addresses: APPROVAL 
XP/XP4/NX host set to 
192.168.0.1, rotation and tiling PC 
port connected to the host set to 
192.168.0.2, rotation and tiling PC 
port connected to the RIP set to 
192.168.0.3, RIP port connected 
to rotation and tiling PC set to 
192.168.0.4 (only for RI P with 

 second network port). 
• Establish network communication 

between the rotation and tiling PC 
and the APPROVAL XP/XP4/NX 
host. 
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Steps Reference 

2. Create the RIP output folders on the 
RIP computer. The RIP uses these 
folders to output files, and these same 
folders are used as the AIT input 
folders. This procedure is usually 
performed by the RIP vendor. 

 

3. Install the Dongle and AIT software in 
the C:\Program Files\AIT folder. 

See “Installing the AIT Software on a Sep- 
arate PC” on page 120. 

4. Start the APPROVAL XP/XP4/NX 
host software. 

5. Start the AIT application. 
 

6. Select Streamer and Plane By Plane 
from the Mode menu. 
 

 

 

7. 
Create donor laydown order 
templates. 
NOTE: These templates are applied 

during hot folder setup. 

See “Donor Laydown Order” on page 54. 

8. Create donor mapping templates. See “Donor Mapping” on page 52. 

 NOTE: These templates are applied 
during hot folder setup.  
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Steps Reference 

9. Create a tiling template. 
 
NOTE: These templates are applied 
during hot folder setup. 

See “Defining a Rotation/Tiling Template” 
on page 73. 

10. Create a Tiling Results folder on the 
rotation and tiling PC. Put this folder 
on the drive not shared with the 
operating system (usually E). 

 

11. Set up these hot folders: 
One Output hot folder that takes 
files from Tiling Results and sends 
them to the APPROVAL 
XP/XP4/NX system 

• One Tiling Results hot folder 
 

NOTE: Donor Mapping and donor 
laydown order must be 
synchronized between the hot 
folders. If not, you will receive 
an error message. 

See “Setting Up Hot Folders” on page 21. 

See “Applying a Rotation/Tiling Template 
to a Hot Folder” on page 75. 

12. On the AIT CD, navigate to the folder 
IMAGES/PS_Images. Choose one of 
the images (25x38_landscape.ps or 
25x38_portrait.ps) and send it 
through the RIP. The RIP file should 
then be located in the AIT input folder. 
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Steps Reference 

13. Activate hot folders. See “Setting Up Hot Folders” on page 21. 

The Rotation and Tiling feature 
converts all file formats to TIFF/.ini.  

14. Because Show Export Setup is 
selected during the hotfolder setup 
procedure, the KODAK 
APPROVAL Setup window appears 
KODAK APPROVAL Setup 
window appears. 

 

 

 

15. Verify the settings and click OK to 
start the rotation and tiling. 
The Show Export Setup window 
appears again. 

16. Verify the settings and click OK to 
start OFE transfer. 

17. Repeat steps 13 and 14 for the 
second tile. 
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 Steps Reference 

18. To return to total automation, de-
select Show Export Setup from the 
Setup menu. 

20. When the transfer starts, the AIT 
Preview window displays the first 
color separation a line at a time. 

 

22. Check the APPROVAL XP/XP4/NX 
host queue manager to verify that the 
job is being transferred. 

The AIT is now configured and ready 
to proof using the Rotation and Tiling 
feature. 



 

 

FBDI File Workflow Configuration 

 147 

FBDI File Workflow Configuration 
The File Based Device Interface Protocol is a simple JDF/JMF 
controlled TIFF-B file interface that is intended to be used for 
connecting other vendors’ devices to the RIP. 
The AIT accepts the following FBDI files: 

� No compression 

� LZW (recommended) 

� CCITT Group 3 

� CCITT Group 4 

� Pack Bits 

NOTE: To set up for a FBDI workflow, you must create a template.txt 
file for the AIT input folder. Template.txt files are used to set 
the Angles and Density. Recipe colors parameters come from 
the list of Pantone and user-defined recipes the AIT uses. 
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Steps Reference 

1. Preliminary setup:  
NOTE: It is highly recommended to 
use a second network card in the RIP 
computer and a crossover cable 
between the host and RIP computers. 

 

• Power up the APPROVAL 
XP/XP4/NX host and log on as 
Administrator. 

• Set the APPROVAL XP/XP4/NX 
host IP Address to 192.168.0.1 and 
the RIP's second network card IP 
Address to 192.1 68.0.2. 

 

NOTE: Get the proper ID from your local 
network administrator.  

• Establish network communication 
between the RIP and the 
APPROVAL XP/XP4/NX host. 

 

2. Create the RIP output folders on the 
RIP computer. The RIP output folders 
must be the same as the AIT input 
folders. This procedure is usually 
performed by the RIP vendor. 

 

3. Install the Dongle and AIT software in 
the C:\Program Files\AIT folder 

See “Installing the AIT Software on the 
Host” on page 115 

4. Start the APPROVAL XP/XP4/NX 
host software. 

5. Start the AIT application. 
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Steps Reference 

 

6. Select Streamer and Plane By Plane 
from the Mode menu. 
 

 

NOTE: The Steamer and Plane By Plane 
mode is automatically selected 
when hot folder are activated. 

 

7. Create donor laydown order 
templates. 

See “Donor Laydown Order” on page 54. 

NOTE:  Under the output tab, these 
templates are applied during hot folder 
setup. 

 

8. Create donor mapping templates. 
NOTE: These templates are applied 

during hot folder setup. 

See “Donor Mapping” on page 52. 
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Steps Reference 

9. Set up and activate the hot folders. 
The AIT is now ready to transfer to the 
APPROVAL XP/XP4/NX host via 
OFE. 

 
 

The Specific Input Plugin should be 
TIFF BM. 
 
The input trigger file type extension 
should be *.jmf for Tiff BM

See “Setting Up Hot Folders” on page 21. 
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Steps Reference 

10. Create a template.txt file to apply to 
the AIT input folder. 

See “Creating Templates” on page 26. 

NOTE: The template.txt file is used to 
set the density, angles X and 
Y offset, number of copies, 
and media savings. During 
hot folder setup the RIP's 
drive that was shared will be 
automatically mapped on the 
APPROVAL XP/XP4 host. 

 

11. Enter a test file or copy a test file into 
the input folder. Remember to copy 
the whole MetaDimension job folder 
into the input folder. Once the folder 
is in the input folder, the AIT waits 5 
seconds before the job starts 
transferring. 
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Steps Reference 

Because Show Export Setup is selected 
during the hotfolder setup procedure, the 
KODAK APPROVAL Setup window appears 
KODAK APPROVAL Setup window 
appears. 

 

 

 

NOTE: When Hot Folders are 
activated the Show Export 
Setup becomes unchecked. 
To select Show Export Setup 
activate the Hot Folders and 
recheck the Show Export 
Setup. 

12. Verify the setting and click OK to start 
the OFE transfer. 
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Steps Reference 

13. To return to total automation, de- 
select Show Export Setup from the 
Setup menu. 

 

 

NOTE: When Hot Folders are 
activated the Show Export 
Setup becomes unchecked. 
To select Show Export Setup 
activate the Hot Folders and 
recheck the Show Export 
Setup. 
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Steps Reference 

When the transfer starts, the AIT 
Preview window displays the first 
color separation a line at a time. 

 

14. Check the APPROVAL XP/XP4/NX 
host queue manager to verify that the 
job is being transferred. 

The AIT is now configured and ready 
to proof modified TIFF/.ini files. 

 



 

 

Glossary 
 
APPROVAL XP/XP4/NX device Inclusive term for two products: KODAK APPROVAL XP 

Digital Color Proofing System (two page proofer) and 
KODAK APPROVAL XP4 Digital Color Proofing System 
(four page proofer). 

  
ATC files Intermediate files needed for proofing. ATC files are 

transparent to the operator 
  
DCS2 file Type file format generated by a RIP and sent to the AIT for 

proofing 
  
DFE (Digital Front End) Any external RIP that can be 

connected to the AIT for the purpose of proofing to a 
KODAK APPROVAL XP/XP4/NX Color Proofing System 

  
HASP (dongle) (Hardware Against Software Piracy) Device that copy-

protects and enables the AIT software. The HASP is 
plugged into the parallel port of the PC on which the AIT 
software is installed. The HASP is also called a dongle 

  
hot folder Directory that enables the automatic transfer of TIFF/ini 

files from the RIP to your KODAK APPROVAL XP/XP4/ 
NX Color Proofing System 

  
.ini file Provides proofing parameters for proofing a TIFF file 
  
OFE (Open Front End) Computer or proofing system that 

accepts multiple front-end packages for producing 
proofs. 

  



 

 

proofing parameters Proofing data contained in an .ini file that include:  
• Path to individual separation,  
• CMYK,  
• Screen ruling,  
• Angles,  
• Lay down order  
• Donor mapping 
• File height and width 

  
SWOP (Specifications for Web Offset Publications) Standard set 

of guidelines used to evaluate original copy, film 
reproductions, proofs, printing plates, and press sheets. 
Also a set of specifications for color separation films and 
color proofing to ensure consistent color appearance 
between different publications 

  
TIFF/.ini 

Interface by which the external RI P provides the AIT with 
a TIFF file and proofing data, in the structure of an .ini 
file. The AIT converts the file, then outputs to the 
KODAK APPROVAL XP/XP4/NX Digital Color Proofing 
System.     
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